COMMONWEALTH OF VIRGINIA SECTION 12C
STATEWIDE AGENCIES RADIO SYSTEM (STARS) AUTOMATIC VEHICLE LOCATION ATP

12c.  Automated Vehicle Location (AVL) Test Plan

This section provides an overview of the AVL Server Standalone Test Plan. This test is
performed once, during the functional AVL period of Division 1. As additional users are added
throughout the implementation, those users will be tested and operation verified as part of the
vehicle installation process. VSP dispatchers will not be used in the vehicles’ installation
verification process unless requested by STARS Program Director.

The bi-directional verification will start with the GPS receiver and antenna in the vehicle,
process the signal(s) through the GPS receiver, use the IV & D system to process the position
and other data, display the requested data at the terminal and be completed by request for vehicle
position from the AVL server. A system level test will be performed during each Division
implementation.

12c.1.1. Purpose

The AVL Server Test Plan describes the approach and the intended testing activities to
accomplish functional testing of the AVL Server software release. The Test Plan will identify
the software test items, the features to test and pass/fail criteria for each test-case specification.
The AVL system is an integral part of the IV&D network, the traffic associated with the AVL
system is considered within the traffic modeling section.

12c.1.2. Reference Documents
e AVL Server System Administrator Guide
e Premier ATM User Guide

The version of these documents will be the same as the version of equipment and system
provided to STARS. These versions will be provided at the contract design review.

12c.1.3. Configuring the Test Environment

The following provides instructions for setting up the test environment and the software that will
be used as the testing platform. Each item in the following list should be active during each
AVL Server Test Case Script, except where specified differently.

12c.1.4. AVL Server

The following items will be installed on the AVL Server machine. Motorola install the
following along with the AVL Server database or Commonwealth approved equivalents.

e Windows NT, 2000, or XP
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e Structured Query Language (SQL) Server 2000
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12c.1.5. Workstation
The following items will be installed on the Commonwealth-provided test workstation:

e Windows NT, 2000, or XP (or equivalent provided by the Commonwealth)
e Advanced Tactical Mapping (ATM) 5.4.2 or 5.5 with maps (provided by
Motorola)

e AVL Reporting Utility (provided by Motorola)
12c.1.6. Test Cases
This section details the Test Cases used to test AVL Server. Each Test Case will include the
following items.

e A brief description of the item to test.

e A test objective identifying the AVL Server functionality to be tested.

e The expected results to fulfill the test objective.
e Pass or fail criteria.

12c.1.7. AVL Server Software Installation

The following will test the AVL Server software installation process, after the Motorola-
provided hardware arrives and is installed by Motorola.

e Install the AVL Server application from CDROM on a PC with no prior
installation.

Expected results: An icon (shortcut) will automatically appear on the desktop and will have the
ability to launch the AVL application.

OPass OFail
e Following installation of AVL Server, Motorola will perform and verify all
configuration tasks.
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12c.1.8. AVL Server Login

The following will test the login process.
e Activate AVL Server.exe from the installation directory or double-click the
desktop shortcut.

Expected results: The Motorola AVL Server window displays.
[lPass OFail
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The following test scenarios will test the Motorola AVL Server window elements.

12c¢.1.8.1. Interface Status groupbox

The Interface Status groupbox displays connectivity elements, the number of Message Switch
messages received, the total units in emergency status, and total units logged on.

12c¢.1.8.1.1. Message Switch display

Displays the active connections with the Message Switch.

e Loginto AVL Server without a Message Switch connection.

Expected Results: “Not Connected/Timed Out” displays.
OPass OFail

e Once the test environment is set-up as outlined in Paragraph 12c.1.3
Configuring the Test Environment and the Message Switch is listening for a
connection from AVL Server, the following expected results should display
within 15 seconds.
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Expected Results: “1 Active Connection(s)” displays.

OPass OFail

12¢.1.8.1.2. History Logging display

e Displays whether history logging is enabled or disabled and enables the user
to change the setting. Click the Change pushbutton.

Expected Results: “Enabled” displays. An entry is automatically made in the Message form
indicating that history logging is enabled. Vehicle location history will be written to the
AVLSERVER database. Open the AVLSERVER database and verify correct vehicle status is
recorded.

OPass OFail
e Click the Change pushbutton.

Expected Results: “Disabled” displays. An entry is automatically made in the Message form
indicating that history logging is disabled. Vehicle location history will not be written to the
AVLSERVER database.

OPass OFail

12¢.1.8.1.3. Switch Messages Received display
Displays the number of Message Switch messages received by AVL Server.

e Click the Loop Script checkbox to continue looping the AVL.txt script.

Expected Results: The Switch Messages Received List increases each time a message is sent to
AVL Server.

OPass OFail

12¢.1.9. Help/Online Help F1

The following will test the Help Menu functionality.
e Pull down the Help Menu. Select Online Help F1.

Expected Results: AVL Server Standalone displays on the top of the Help Menu. The user is
able to search for help topics accordingly.

OPass OFail
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12¢.1.10. Help/About

The following will test the Help About functionality.
e Pull down the Help Menu. Select About.

Expected Results: Motorola AVL Server displays on the top of the window with the copyright
and correct version information.

OPass OFail

About

otarola %L Server
[c) 2000 Printrak, a botorala Company
Werzion: 3.1
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12c.1.11. File/Options

The Options form enables the operator to set-up various communications parameters.
e Pull down the File Menu, select Options.

Expected Results: The Options form displays.

OPass OFail
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12c¢.1.11.1. ActiveX Data Objects (ADO) Connection String editbox

The following test case scenarios will test the ADO Connection String, used to designate the
identifying connection information.
e Enter the correct path of the ADO (ActiveX Data Objects) Connection String,
be sure each item is separated with a semicolon.

Driver=[ODBC data source]; server=server name; uid= user id; pwd=password; database=name
of the AVL Server database.

Example: LserverNew;DataSource=thompson-lap;UserID=sa;Password=sa

e Restart AVL Server

Expected Results: The connection to the AVL Server is activated when the connection string is
entered correctly.

O Pass O Fail
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e Enter an incorrect path of the ADO (ActiveX Data Objects) Connection
String.

e Restart AVL Server

Expected Results: AVL Server does not connect to the AVLSERVER database.  An error
message will occur specifying the SQL Server error, and AVL Server will not launch.

O Pass O Fail

12c¢.1.11.2. GPS Reporting groupbox

This groupbox enables the operator to set a minimum and maximum time that must elapse before
a GPS-equipped vehicle reports its location and/or a minimum reporting distance that the vehicle
must travel before it reports its location. The default cadence settings (set-up in this groupbox)
are used whenever a vehicle is in a unit status that does not have cadence settings configured.
The AVL system will be configured based upon the STARS system performance parameters
defined by the Coverage and Traffic Section 4 of the Contract.

The GPS position reported will be verified by a handheld GPS unit at the location of the
transmission.

12¢.1.11.3. Minimum Reporting Times

The STARS has the capability of configuring the AVL system to support minimum reporting
parameters such as: distance traveled, time since last report. The STARS and performance
guarantees are configured based on manual polling and when the user initiates a traffic stop, rest
area check, and occupied disabled vehicle status changing events.

12c¢.1.11.4.Client Options groupbox

The Client Options groupbox, found on the Options Menu, enables the operator to set-up the
GPS Timeout and Report All Vehicles.

The following test case scenarios will test the editboxes and checkboxes available in the Client
Options groupbox.
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12¢.1.11.4.1. GPS Timeout (Minutes) editbox

This editbox enables a user to type the number of minutes that AVL Server will wait until it
times out.

e Enter 1 in the GPS Timeout (Minutes) editbox.

Expected Results: After one minute, AVL Server sends out a new location message for the
non-responding vehicles stating “Unit Time Out on AVL Server: <vehicle ID>".

O Pass O Fail

e In Premier ATM, access the units list.

Expected Results: The ATM units list display all vehicles highlighted blue and lists “-
999.000000” in the Latitude and Longitude fields.

0 Pass 0 Fail

12c.1.12. File/Exit Menu
The following tests the File/Exit process:

e Select File/Exit.

Expected Results: The AVL Server Standalone window closes without further incident.
UPass UFail
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12c¢.1.13. Monitor Vehicle form
The Monitor Vehicle form enables the operator to view detailed information for a selected
vehicle. The information on the form updates in real time. The following test scenarios will test
the Monitor Vehicle form elements.

e Loginto AVL Server.

e Select the Monitor Vehicle tab.

Expected Results: The Monitor Vehicle form displays.
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12c¢.1.13.1. Selection groupbox

The Selection groupbox enables the operator to select the vehicle call sign from the dropdown
list. The call sign contains the agency name and unit ID.

12¢.1.13.1.1. Select Call Sign dropdown list

e In the Monitor Vehicle form, click the down arrow after Select Call Sign
dropdown list.

e Select a call sign from the dropdown list.

Expected Results: The Results display lists all information associated with the selected vehicle.
Since the Message Switch is providing location data for the selected vehicle, the Results area is
actively updated with the latitude/longitude, speed, heading, and GPS TimeStamp.

O Pass O Fail
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12¢.1.13.1.2. Poll Now pushbutton
This enables the AVL Server operator to start polling the selected vehicle.
e Click the Poll Now pushbutton.

Expected Results: The vehicle information is updated.

0 Pass OFail O

12c.1.14. Monitor Fleet form

This form enables the operator to view all vehicles that are currently configured. The
following test scenarios will test the Monitor Fleet form elements.

e Click the Monitor Fleet tab.

Expected Results: The Monitor Fleet form displays.
0 Pass 0 Fail

Comment: A response from a Poll On Demand has the same content as a regular GPS report.
This function is initiated at the ATM workstation only. If the Message Switch is running, the
vehicle information will then be updated when a location request is sent for the monitored
vehicle by the ATM.
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12c.1.14.1.1. Update pushbutton

This pushbutton enables the operator to update the spreadsheet information with the most current
information (the spreadsheet does not update in real time to save system resources).

e Click the Update pushbutton.

Expected Results: The spreadsheet is automatically updated with the current vehicles signed on
with their routing 1D, call sign, unit status, and last GPS location information.

O Pass O Fail

12¢.1.14.1.2. Sorting feature

The Monitor Fleet form supports sorting by the vehicle, call sign, unit status, and last timestamp
fields.

e Click each of the column headings to automatically order the column data.

Expected Results: Each column selected is automatically sorted when the column heading is
clicked.

O Pass O Fail
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12¢.1.15. GPS Status form

The GPS Status form displays a message each time AVL Server receives a GPS Message
specifying the Vehicle ID of the sender. The following test scenarios will test the GPS Status

form elements.
e Select the GPS Status tab.

Expected Results: The GPS Status form displays with the messages received from the Message
Switch.
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12c¢.1.16. Vehicle Configuration form
The Vehicle Configuration form enables the operator to edit, add, or delete a vehicle from the
vehicles list. The following test scenarios will test the Vehicle Configuration form elements.

e Click the Vehicle Configuration tab.

Expected Results: The Vehicle Configuration form displays.

‘21 Motorola AYL Server [_[= [ x]
File  Help
ATH Clents:
Interface Status
CAD Server: Unknown CaD Messages Received: 0
Message Switch: 1 Active Connection(s] Switch Messages Received: 3
History Logaing:  Enabled Change | Units In Emergency Status: 0

Tatal Units Logged On: 0

Muﬂitur\u’eh\c\el I anitor FIEEII GPS Status  Yehicle Configuration |Messages|

Select Vehicle 1D: |{SRARES hd Edit | Delete
Add Mew |

12c¢.1.16.1. Select Vehicle ID editbox

The Select Vehicle ID dropdown list enables the operator to select the vehicle ID to edit or delete
from the vehicles list.

MOTOROLA
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12¢.1.16.1.1. Add New pushbutton (static vehicle configuration)
The Add New pushbutton enables the operator to add a new vehicle to the vehicles list.
e Click the Add New pushbutton.

Expected Results: The Vehicle Configuration dialog box displays.

O Pass O Fail

“Wehicle ID || Routing D I

Drescription: I

[~ GPS Configuration
Location Message Format; | ¥ehicle Not GPS Equipped j'
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[ ATk obile Configuration

I~ ATMMobile Available Al Routing ID
ATMMobile Interface Index: |1 vI

Ok | Cancel |

e Vehicle ID: Type the name of the new vehicle ID. The value for the Vehicle
ID consists of the agency ID and vehicle number. For example: BO90001.

e Routing ID: Type the name of the routing ID. The routing ID is the ID that
the Message Switch uses to send a message to a specific unit and is normally
the Modem ID or an MDT chip ID.

e Description: Type a description for the vehicle.

12c.1.16.1.1.1.
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GPS Configuration groupbox (check TAIP Position Velocity)

e Location Message Format dropdown list. Click the down arrow and select
“TAIP Position Velocity PV.” This indicates that AVL Server will not
perform an inverse differential because the messages are smaller (this option
decreases radio network traffic). This only affects messages sent out from
AVL Server to the message switch (i.e., polling configuration and poll now
messages).

e GPS Interface Index editbox: Type 1. This is the configured index of the
Message Switch that will provide GPS messages.

e Set Polling interval checkbox: Click to activate the checkbox.

Expected Results: A check appears in the box indicating that the AVL Server will change the
vehicle’s polling configuration when the vehicle status changes

O Pass 0 Fail

12c.1.16.2. Test TAIP Long Navigation (LN)

e Click the Add New pushbutton.

Expected Results: The Vehicle Configuration dialog box displays.
O Pass O Fail.

e Vehicle ID: Type the name of the new vehicle ID.
e Routing ID: Type the name of the routing ID.

e Description: Type a description for the vehicle.

12¢.1.16.2.1.1. GPS Configuration groupbox (test TAIP Long Navigation LN)

e Location Message Format dropdown list. Click the down arrow and select
“TAIP Long Navigation LN.” This indicates that AVL Server will perform an
inverse differential for the majority of units. This message is larger because it
contains additional information that is required to perform the inverse
differential.

e GPS Interface Index editbox: Type 1. This is the configured index of the
Message Switch that will provide GPS messages. This value corresponds to

MOTOROLA
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the different message switch configuration in the AVLServer.INI file. This
value is typically 1 because most systems typically have 1 message switch.

e Set Polling interval checkbox: Click to deactivate the checkbox.

Expected Results: A check does not appear in the box indicating that the AVL Server will not
change the vehicle’s polling configuration.

O Pass O Fail

12¢.1.16.2.2. Edit pushbutton

The Edit pushbutton enables an operator to edit an existing vehicle’s information.

e Click the down arrow and select an existing vehicle from the list.

e Click the Edit pushbutton.

Expected Results: The Vehicle Configuration dialog box displays with editboxes populated
with information pertaining to the vehicle selected. Additionally, the vehicle list found in the
Monitor Vehicle form or Monitor Fleet (after pressing the “Update” button) form displays the
added information.

0 Pass O Fail
¥ehicle Configuration [ %]
ehicle 10 IEFEENG2 Fauting 10 |192.215.230.?8

Description: IFire Engine

— GPS Configuration
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e Change parameters in the Vehicle Configuration dialog box.
e Click OK.
e Click the Edit pushbutton.

Expected Results: The Vehicle Configuration dialog box displays the changed parameters.
Additionally, the vehicle list found in the Monitor Vehicle form or Monitor Fleet (after pressing
the “Update” button) form displays the added information.

O Pass O Fail

12c.1.16.2.3. Delete pushbutton
This pushbutton enables the user to delete a selected vehicle from the vehicles list.

e Select the vehicle to delete by clicking the down arrow after Select Vehicle ID
and select the vehicle from the dropdown list.

e Click the Delete pushbutton.

Expected Results: A Confirmation dialog box displays prompting the user to confirm deletion.
If Yes is selected, the vehicle is removed from the vehicles dropdown list. Additionally, the
vehicle list found in the Monitor Vehicle form or Monitor Fleet form (after pressing the Update
button) no longer displays the deleted item. If No is selected, the dialog box closes and the user
is returned to the Vehicle Configuration form without changes.

[0 Pass 0 Fail

@ Delete Vehicle: TEST? Are you sure?
o e |
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12c¢.1.17. Message form
The following test scenarios will test the Message form elements.
e Review the messages in the Message list.

Expected Results: Messages should display with the date first, followed by the time, followed
by the message or process received and sent by AVL Server.

[ lotorola
ATM Clients:
Intetface Stetus
CAD Server: Unknown CAD Messages Received:
Message Switch: Mot Connected/Timed Dut  Switch Messar eceiver
Histow Logging: Enabled Change Units In Emergency Status:
Total Urits Logged Or: 0
Monitor Wehicle | Monitor Fleet | GPS Status | Wehicle Configuration  Messages |
7172003 10:47.33 AM - 2VLServer: History Logging Enabled = |
7/1/2003 10:01:22 &M - AL Server: YWehicle D atabase Loaded.
7/1/200310:01:21 &M - AL Server: Loading Yehicle Database.
7172002 10:0:20 &M - 8L Server: History Looging Disebled
K ;l_l
dhstart ||| Blnto.. | Gus.. | uliree . ([@mot.. Bwer.., | @an .. | g, | EE A3 B = osaam

e Press the History Logging Change pushbutton.

Expected Results: A message displays indicating the changed action (AVLServer History
Logging Disabled or AVLServer History Logging Enabled depending upon what it was changed
to) with the date first, followed by the time, followed by the corresponding message.

[0 Pass 0 Fail

12c.2 ATM Interface

AVL Server distributes vehicle locations to ATM applications. When a vehicle location is
received for a unit belonging to the operator’s coverage area, AVL Server notifies the operator’s
ATM application of the unit’s new location.

The series of tests in paragraphs 12¢.5.1.1.1, 12¢.5.1.2.1, 12¢.5.1.2.2, 12¢.5.1.2.3, 12¢.5.1.2.4,
12¢.5.1.2.5,12¢.5.1.2.6 and 12c¢.5.1.2.7 describe tests applicable to ATM equipped networks.
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12c.2.1.1. Unit Update
Displays the latitude, longitude, and time of the last reported location for AVL-equipped units.

12c.2.1.1.1. Test AVL Info pushbutton on the Unit Update dialog box
e Onthe ATM Toolbar, click the Unit Update button.
e Inthe ATM window, click the AVL-equipped unit.

Expected Results: The Unit Update dialog box displays. All units within 200 feet of
the place clicked on the map are listed in the dialog box (the 200 foot value is
configured in Premier ATM Configuration Utility).

O Pass O Fail

e Select the AVL-equipped unit from the Unit Update dialog box.

e Click the AVL Info pushbutton.

Expected Results: The AVL Information dialog box displays with the last reported
latitude, longitude and time for the selected vehicle.

O Pass O Fail

e From the AVL Information dialog box, select the poll pushbutton.

Expected Results: The Response to Poll unit dialog box displays with the Unit ID,
latitude and longitude.

O Pass O Fail

e From the Response to Poll unit dialog box, click Center Main Window on Unit
pushbutton.

Expected Results: Premier ATM centers the unit in the ATM Main window.
0 Pass 0 Fail
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12c.2.1.1.2. Test Out-of-Service Type Code Events from Premier
MDC

e Enter Traffic Stop, Rest Area or Occupied Disable Vehicle Check into Premier
MDC Client.

e Out-of-Service Type Code event is created in VSP CAD.
e GPS coordinates updated in Premier AVL Server.

Expected Results: Premier MDC forwards the Out-of-Service Type Code to VSP
CAD and Premier AVL Server. Out-of-Service Type Code event is created in VSP
CAD and GPS Coordinates updated for the unit in Premier AVL Server. Visible
update of GPS coordinates are verified by Monitor Fleet display.

[0 Pass 0 Fail

12c¢.2.1.2. Units List

The following Test Cases test the AVL Server-related items available from the Premier ATM
Units list.

12c.2.1.2.1. Identify AVL-equipped vehicles

The units list enables the operator to identify whether vehicles are AVL-equipped.
e From Premier ATM, access the ATM Units List.
e Click the List Fields pushbutton.
e From the Available Fields list, add AVL Equipped to the target list.

e Select the OK pushbutton.
Expected Results: AVL-equipped units display in the units list with a value of Y’
in the AVL Equipped column.

O Pass O Fail

12c.2.1.2.2. Identify last vehicle location update date and time

The units list enables the operator to identify the last time ATM received a vehicle location
update from AVL Server for AVL-equipped vehicles.

e From Premier ATM, access the ATM Units List.
e Click the List Fields pushbutton.

MOTOROLA
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e From the Available Fields list, add Last Update Date, add Late Update Time to
the target list.

e Select the OK pushbutton.
Expected Results: AVL-equipped units display the last date and time a vehicle
location was received from AVL Server.

[0 Pass 0 Fail
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12c.2.1.2.3. Identify vehicle speed

The units list enables the operator to view the vehicle speed when available from AVL Server.
e From Premier ATM, access the ATM Units List.
e Click the List Fields pushbutton.
e From the Available Fields list, add Speed to the target list.

e Select the OK pushbutton.
Expected Results: AVL-equipped units display the speed of the last date and time a
vehicle location was received from AVL Server.

O Pass O Fail

12c.2.1.2.4. Units List color display

Units in the units list display in various colors based on the status of their location and whether
they are AVL-equipped.

e Access the ATM Units List.

Expected Results: AVL-equipped units with known latitude and longitude values,
display in white. This indicates that a GPS location has been received since the
operator signed on.

O Pass 0 Fail

e Inthe AVL Server Options Menu, enter a GPS Timeout (Minutes) value of 1
(indicating a timeout value of one minute).

e After one minute, access the ATM Units List.

Expected Results: AVL-equipped units that the message switch was tracking are
highlighted blue and the Latitude and Longitude fields contain the value -
999.000000, indicating that GPS locations have not been received for the AVL-
equipped units.

O Pass O Fail

12¢.2.1.2.5. Poll pushbutton
Enables the user to poll a selected unit.
e Access the ATM Units List.
e Select an AVL-equipped vehicle to poll from the units list.

e Select the Poll pushbutton.

Expected Results: Premier ATM displays a Response to Poll unit dialog box
containing the Unit 1D, Unit latitude, Unit longitude and option to center the unit in
the Main Window.

[0 Pass 0 Fail
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e Click the Center Main Window on Unit pushbutton in the Response to Poll unit
dialog box.

Expected Results: Premier ATM centers and tracks the polled unit in the ATM
Main window.

O Pass O Fail

e Access the ATM Units List.

e Select a vehicle that is not AVL-equipped from the units list.

Expected Results: The Poll pushbutton turns gray. The user is unable to poll the
unit.

O Pass O Fail

12c¢.2.1.2.6. Shortest Path pushbutton

Enables the user to determine the shortest path between the unit and selected location.
e Access the ATM Units List.

e Select the AVL-equipped vehicle from the Units list.

e Select the Shortest Path pushbutton.

Expected Results: Premier ATM highlights in red the shortest path between the
AVL-equipped unit and the selected location along with Drive Directions.

O Pass 0 Fail

12c¢.2.1.2.7. GPS Health pushbutton
Enables the user to determine the GPS health of the selected unit that is AVL-equipped.
e Access the ATM Units List.

e Select an AVL-equipped vehicle.

e Select the GPS Health pushbutton.

Expected Results: A GPS Health Response dialog box will display on ATM.
0 Pass 0 Fail
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12c¢.2.1.3. Message window

Premier ATM displays messages about potential duplicates and AVL-related warnings in the
Message window that is automatically opened when ATM is accessed (the Message window is
minimized upon ATM login).
Action:
e Pull down the ATM Window Menu, select Message.

e Review the messages displayed in the window.

Expected results:
e AVL related messages display

O Pass O Fail
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